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CorelDRAW® Graphics Suite X4 is an affordable and comprehensive suite of
intuitive page-layout, illustration, photo-editing, and bitmap-to-vector tracing
applications. The trusted choice of professional and aspiring designers, the suite
includes new tools that fuel the creative process, simplify project management,
and optimize the graphic design workflow.

Users of CorelDRAW Graphics Suite X4 can confidently tackle a wide variety of
projects — from logos and Web graphics to multipage brochures and eye-
catching signs. With its text and page-layout enhancements, market-leading file
format compatibility, and high-quality content, this powerful suite is the
ultimate design partner to help users turn inspiration into stunning results.

For increased design flexibility, CoreIDRAW® X4 now lets users create
independent layers for each page of a document. The new CoreDRAW®
ConceptShare™ docker is a valuable online collaboration tool, and the ability to
import PDF files with comments makes it easier than ever to work with
colleagues and clients. In addition to providing its redesigned workspace icons,
menus, and controls, CoreIDRAW X4 includes an enhanced Print Merge wizard, a
new Table tool for drawing and editing tables, and integration with
WhatTheFont™ — the font identification service from MyFonts.com.

With Corel PHOTO-PAINT® X4, the workspace icons, menus, and controls have
also been redesigned and many image-adjustment features now have an
integrated histogram, which provides visual feedback in real time. Users can
now work with raw camera files more easily, and new thumbnail previews make
it easier to find files. In addition, Corel® PowerTRACE™ X4 has been enhanced
to give users more control over bitmap-to-vector conversion.

Rounding out the suite, Corel CAPTURE™ X4 is a screen-capture utility that lets
users copy images of their computer screens in a single click. With the new
Welcome screen, users have a centralized location to start new projects, access
recently used documents, get instructional information, and view inspiring
designs from other CoreIDRAW Graphics Suite users around the world. Plus, the
CoreIDRAW® Handbook — Insights from the Experts provides artwork, helpful
advice, and design techniques from professional designers.
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Design professionals in advertising and printing industries spend much of their
time creating and editing graphics, working with text, and retouching photos.
With time-saving features such as interactive layout tables, live text formatting,
and independent page layers, CoreIDRAW Graphics Suite X4 gives them
innovative design tools that optimize their workflow.

Other design professionals focus primarily on sign making, screen printing, and
engraving. These users frequently repurpose and combine such content as
graphic designs, scanned logos, clipart images, and fonts. With powerful image-
editing capabilities, specialized fonts, tracing software that turns bitmaps into
editable vector graphics, and high-quality content, CoreIDRAW Graphics

Suite X4 gives them a comprehensive, versatile, and affordable solution.

Creative professionals focus primarily on graphic design for print and for the
Web. In addition to its intuitive page-layout and design tools, CoreIDRAW
Graphics Suite X4 gives them market-leading compatibility with commonly used
file formats.

For entrepreneurs and small to medium-size businesses interested in creating
marketing materials in-house, CoreIDRAW Graphics Suite X4 provides powerful
text and page-layout tools that ensure professional-looking results. Self-taught
in graphic design, these occasional users can confidently turn to CoreDRAW
Graphics Suite X4 to modify existing designs, to retouch photos, and to create
ads, flyers, and other marketing collateral.

Business users in medium-size to large enterprises value the ability to work with
more than 100 file formats as well as create professional, graphically rich
projects — from sales presentations to Web graphics.

Hobbyists do not use graphic design software to earn a living, but they do use it
occasionally to create projects — such as newsletters, calendars, banners, and
photo layouts — for personal or community use. With an extensive collection of
learning tools, CoreIDRAW Graphics Suite X4 makes it easy to create impressive
results without professional training.
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e CorelDRAW® X4: CorelDRAW X4 is an intuitive vector-illustration and
page-layout application that meets the demands of today’s busy design
professionals and occasional graphics users. It delivers results fast, whether
users are creating a company logo or working toward demanding
production schedules.

e Corel PHOTO-PAINT® X4: Corel PHOTO-PAINT X4 is a professional
image-editing application that lets users quickly and easily retouch and
enhance photos. It is specifically designed for use in a graphics workflow.

e Corel® PowerTRACE™ X4: Professional designers often receive
poor-quality bitmap images from clients and face the challenge of turning
these bitmaps into high-quality vector images for business cards, brochures,
signs, or other promotional items. Corel PowerTRACE X4 solves this problem
by letting users quickly and accurately convert bitmaps into editable vector
graphics.

e Corel CAPTURE™ X4: Corel CAPTURE X4 is a one-click screen-capture utility
that lets users capture images from their computer screens.

e Barcode wizard: The Barcode wizard lets users generate bar codes in a
wide range of industry-standard formats.

¢ Service Bureau Profiler: The Service Bureau Profiler helps users prepare
their work for professional output.

e Duplexing wizard: The Duplexing wizard helps users optimize their work
for printing two-sided documents.

e Bitstream® Font Navigator®: The Bitstream Font Navigator is an award-
winning font manager for the Windows® operating system. It lets users
manage, find, install, and preview fonts.

CorelIDRAW
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¢ A collection of more than 10,000 high-quality clipart and digital images
includes 4,000 new images, all of which were individually selected to meet
the needs of design professionals and occasional graphics users

e New! 1,000 professional high-resolution digital photos

¢ 1,000 OpenType® fonts, including 75 Windows Glyph List 4 (WGL4) fonts and
10 single-line engraving fonts

e 80 professionally designed templates

e User guide

e CorelDRAW® Handbook — Insights from the Experts
e Digital content guide

* Quick-reference card

e Help files

¢ 2 hours of training videos on DVD

e  Windows XP (with Service Pack 2 or later), or Windows Vista® (32-bit or 64-
bit editions)

e 512 MB of RAM, 275 MB of hard disk space

¢ Pentium® lll, 800MHz processor or AMD Athlon™ XP
e 1,024 x 768 or better monitor resolution

e DVD drive

e Mouse or tablet

CorelIDRAW
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CorelDRAW Graphics Suite X4 is an affordable and comprehensive suite that
combines intuitive page-layout, illustration, photo-editing, and bitmap-to-vector
tracing applications. The trusted choice of professional and aspiring designers,
the suite includes new tools that fuel the creative process, simplify project
management, and optimize the graphic design workflow.

With its redesigned and modernized user interfaces, new collaboration tools,
and enhanced features, CoreIDRAW Graphics Suite X4 can help users streamline
their workflow without compromising creativity or flexibility.

New! Modernized user interface (Ul): For CorelDRAW Graphics Suite X4,
the user interface has been redesigned. New icons, menus, and controls give the
applications a fresh appearance and provide a more intuitive working
environment.
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The redesigned CoreIDRAW X4 user interface
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New! CorelDRAW® ConceptShare™: The new CorelDRAW ConceptShare
docker is a valuable online collaboration tool. In a Web-based environment,
CorelDRAW ConceptShare lets users share their designs and ideas with
colleagues or clients in real time. Users can easily create multiple workspaces,
upload their designs, and invite others to provide feedback or submit their own
ideas.

Enhanced! Corel® PowerTRACE™ X4: With Corel PowerTRACE X4, users
can quickly and easily trace bitmaps, converting them into editable and scalable
vector images. The new Centerline Trace method produces more accurate
strokes and is perfect for tracing line drawings or signatures. To control which
colors appear in the traced results, users can easily edit, merge, or delete colors
on the color palette that is generated by PowerTRACE. In addition, improved
smoothing and corner control help users optimize their traced results.

The new Centerline Trace method is ideal for tracing line drawings or signatures.

Using the Centerline Trace method

1 In CorelDRAW X4, click File » Import.

2 In the Import dialog box, browse to the folder that contains a bitmap
of a line drawing or a signature that you want to trace, select the
bitmap, and click Import.

3 On the drawing page, click where you want to place the bitmap, or to
center the bitmap on the page, click Enter.

4 Click Bitmaps » Centerline Trace, and choose one of the following:

¢ Technical illustration — to trace black-and-white illustrations
with thin, faint lines

¢ Line drawing — to trace black-and-white sketches with thick,
prominent lines

If necessary, adjust the traced results by using the controls in the
PowerTRACE dialog box.

New! Windows® Color System support: CoreDRAW Graphics Suite X4
supports the Windows Color System, which enables users to more closely match
colors between Corel and Microsoft applications.

CorelIDRAW
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New! Adobe® Color Management Module: CoreIDRAW Graphics Suite
now supports the Adobe Color Management Module (CMM), which provides
consistent color transformations by using industry-standard International Color
Consortium® (ICC) color profiles. This makes it easy for users to closely match
colors between Corel and Adobe applications.

Enhanced! Print Merge: With CorelDRAW X4, the Print Merge wizard
makes it easier than ever to combine text from a data source with a drawing. As
a result, invitations, labels, certificates, or other projects that place unique,
personalized text on the same design are faster and easier to produce. In
addition, users now have the ability to output a print merge to the CoreIDRAW
file format (CDR). CoreIDRAW X4 supports the following data sources: text
(TXT), comma-separated values (CSV), Rich Text Format (RTF), and other files
supported by Open Database Connectivity (ODBC) data sources.

Enhanced! Customizable workspace: In addition to letting users
customize the application’s command bars, commands, and button
arrangements, CoreIDRAW Graphics Suite X4 includes preset workspaces that
have a similar look and feel to those of Adobe® Photoshop®,

Adobe® lllustrator®, or Microsoft® Office. These preset workspaces make it
easier for users to transition to CorelDRAW Graphics Suite. Users can also export
a custom workspace to share it with other users.

Enhanced! PDF Comments support: CoreIDRAW X4 now supports PDF
Comments, which gives users the option of importing comments and
annotations when they import a PDF file. This makes it quicker and easier for
users to access and leverage feedback from clients and colleagues.

Enhanced! Microsoft® Visual Basic® for Applications 6.4: For users
who want to automate their workflow, CoreIDRAW Graphics Suite X4 supports
the latest version of Microsoft Visual Basic for Applications (VBA) 6.4.

New! Dynamic product updates: With CorelDRAW Graphics Suite X4, the
Welcome screen is a valuable resource that provides users with immediate access
to new content, tips and tricks, product registration, and the latest product
updates. From within the application, users can choose to install product
updates automatically or to receive notification when updates are available.

With market-leading file format compatibility, a convenient file search, and an
abundance of new, editable content, CoreIDRAW Graphics Suite X4 makes it
easier for users to exchange files and find the right design asset for the job.

Enhanced! Windows Vista® integration: CorelDRAW Graphics Suite X4
has been designed to take advantage of the latest innovations from the
Windows Vista operating system. From within the operating system dialog
boxes, users can search for files by author, subject, file type, date, keywords, or
other file properties. Users can also easily add keywords or other notes when
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saving files in order to better organize their projects. In addition, users can edit
file properties from within the CorelDRAW Graphics Suite X4 applications or
from Windows Explorer and Windows Vista Search. Users of Windows XP can use
Windows Desktop Search or any other desktop search application that supports
the iFilter format.

New! Content: CorelDRAW Graphics Suite X4 includes an abundance of new,
editable content on an easily searchable DVD. Users can browse through 10,000
clipart images to find inspiration for their next design project. These high-
quality vector graphics are easily adapted. In addition, 1,000 new high-quality
photos on various subjects and themes are included.

New! Specialized fonts: With a collection of specialized fonts, CoreIDRAW
Graphics Suite X4 helps users ensure that their output is optimized for its
intended audience. An extended selection of new fonts includes single-line
engraving fonts and OpenType® cross-platform fonts, which offer enhanced
language support for Latin, Greek, and Cyrillic outputs in WGA4L format.

Engraver Fonts

A collection of specialized fonts includes engraving fonts.

New! Template search and preview: In CorelIDRAW X4, the New From
Template dialog box has been completely redesigned to provide users with more
information so that they can easily choose the right template for the job. Users
can now preview templates by Type, such as flyer or postcard, or by Industry,
such as hospitality, retail, or services. Users can also search for templates by using
keywords.

New! Professionally designed templates: CoreIDRAW Graphics Suite X4
includes more than 80 professionally designed and customizable templates,
which give users a great starting point for their designs. Flexible and easy to
repurpose, the templates are now accompanied by Designer Notes. These notes
provide information on the design choices made for the template, tips for
outputting a design based on the template, and instructions for customizing the
template while still adhering to design principles.

dandmade Crafts

An abundance of customizable templates are a great starting point for design projects.
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Enhanced! Adobe® product support: To ensure a seamless workflow,
CorelDRAW Graphics Suite X4 provides enhanced support for Adobe Photoshop
CS3, Adobe lllustrator CS3, PDF 1.7, PDF/A, and Adobe® Acrobat® 8. When
exporting CorelDRAW Graphics Suite X4 files to the new Adobe Illustrator CS3
format, users can now choose a format for text in the exported files. This makes
it easier for users to exchange files between the applications. In addition, users
can save files to the PDF/A format — the file format approved by the
International Organization for Standardization (ISO) for long-term archiving of
electronic documents.

New! File format support: CoreIDRAW Graphics Suite X4 maintains its
position as market leader in file format compatibility by adding support for
Microsoft® Publisher (versions 2002, 2003, and 2007). Users can also expect
seamless compatibility with Microsoft® Word 2007, AutoCAD® DXF™ and
AutoCAD® DWG™ (versions R2.5 to 2007), and Corel® Painter™ X, making it
easier than ever to exchange files with colleagues and clients.

New! Thumbnail previews: New, high-quality thumbnail previews make it
easier to find and organize CoreIDRAW and Corel PHOTO-PAINT files.

High-quality thumbnail previews make it easier for users to find their files.

With an interactive Table tool, independent page layers, real-time text
formatting previews, and an integrated font identification feature,
CorelDRAW Graphics Suite X4 can help users accelerate document design.

New! Interactive tables: The new, interactive Table tool in CoreIDRAW X4
lets users create and import tables to provide a structured layout for text and
graphics. Users can easily align, resize, or edit tables and table cells to suit their
designs. In addition, users can convert delimited text into a table or convert a
table into delimited text. Users can also easily add and adjust images in
individual table cells.
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The new Table tool makes it easy to create a structured layout
with graphic elements embedded in table cells.

Creating a table

1 In CorelDRAW X4, click the Table tool I in the toolbox.

2 On the property bar, type values in the Number of rows and
columns boxes.

The value you type in the top portion specifies the number of rows;
the value you type in the bottom portion specifies the number of
columns.

3 Drag diagonally to draw the table.

New! Independent page layers: With CoreIDRAW X4, users can now
control and edit layers independently for each page of a document, reducing
the occurrence of pages with empty layers. Users can also add independent
guidelines for individual pages and master guidelines for an entire document.
This gives users the ability to create different layers on a page-specific basis,
unconfined by a single document structure. In addition, the new Duplicate Page
command gives users the flexibility to copy a page with all objects included or
just the layer structure, making it easier to repurpose existing designs.

Working with independent page layers
1 In CorelDRAW X4, click File » New.

2 C(Click Window » Dockers » Object Manager.

CorelIDRAW
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3 In the upper-right corner of the Object Manager docker, click the
flyout button, and click New Layer.

4 Type a name for the new layer, or click to accept the default naming
convention (Layer 2).
Page 1 of your document now has two independent layers. To make a
layer active, click the layer name.

The name of the active layer is indicated by a bold red font.

5 To create a new page, click the flyout button in the top right corner of
the Object Manager docker, and click New Page.

6 Repeat steps 3 and 4 to create a new layer.
Page 2 of your document now has two independent layers.

New! Live text formatting: CoreIDRAW X4 introduces live text formatting,
which lets users see how a text formatting change will look before applying it to
a document. This handy and time-saving formatting aid reduces the need to
undo and redo unsatisfactory changes. Users can now scroll through and
preview many different formatting options, including fonts, font size, and
alignment.

Previewing text formatting

1 In CorelDRAW X4, click the Text tool ¢ in the toolbox.

2 Drag in the drawing window to size the paragraph text frame, and
type to add text.

3 Onthe property bar, click the Font List list box, and scroll through the
available fonts.

As you hover over a font, CoreIDRAW X4 displays a preview of how
that font will look when applied to your document.

New! Font identification: CorelDRAW Graphics Suite X4 now integrates
with WhatTheFont™, the online font identification service from MyFonts.com.
Users can save time by immediately identifying the font used in existing designs
or artwork received from clients (English only).
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Integration with WhatTheFont makes it quick and easy to identify fonts.
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New! Mirror paragraph text: With CoreIDRAW X4, users can now
interactively mirror text. Users can mirror text horizontally or vertically, or both,
which is essential for outputting content for certain specialized devices.
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Users can easily mirror paragraph text.

Mirroring paragraph text

In CorelDRAW X4, click the Text tool #: in the toolbox.
On the drawing page, drag to create a paragraph text frame.

Type to add text to the frame.

P W N =

On the property bar, click one or both of the following buttons:

¢ Mirror horizontally — flips the text characters from left to right
e Mirror vertically — flips the text characters from top to bottom

Enhanced! Quotation marks: CorelDRAW X4 users can now customize
quotation marks for specific languages. Users can edit quotation mark styles and
choose which style is used when typing in different languages. For example,
users can change the style of double, single, and straight quotation marks for a
specific language.

With CoreIDRAW Graphics Suite X4, it's never been easier to get started, find
inspiration, or gain knowledge. The Welcome screen, expert tutorials, and other
learning tools offer invaluable assistance to both new and experienced users.

New! Welcome screen: With a new Welcome screen, CorelDRAW Graphics
Suite X4 provides users with a centralized location to access recently used
documents, templates, and learning tools, which include Tips & Tricks and video
tutorials. To inspire users, the Welcome screen also includes a gallery that
showcases designs created by CoreIDRAW Graphics Suite users around the world.

CorelIDRAW
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New! CoreIDRAW® Handbook — Insights from the Experts: This new
book showcases practical, real-world examples of accomplished designs by
CorelDRAW experts. By deconstructing designs and sharing their wisdom and
best practices, experts from a variety of industries demonstrate the power of
CorelDRAW Graphics Suite X4.

New! Training videos: CorelDRAW Graphics Suite X4 includes 2 hours of
training videos on DVD. Topics include illustration, design, and image-editing
fundamentals, industry-specific design principles, and output details for various
media, such as print or the Web.

Enhanced! CorelTUTOR™: With CorelTUTOR™, users can access online,
project-based tutorials that help them learn and use the applications. In addition
to touring the workspaces of both CoreIDRAW X4 and Corel PHOTO-PAINT X4,
users can learn how to work with page-layout features, get started with bitmap-
to-vector tracing, try the enhanced print-merge functionality, create a logo, and
much more.

New! CoreIDRAW® community site: Accessible from within the
application, the CoreIDRAW.com community site gives users a place to get
together to share information and learn from other users. Combining forums,
blogs, galleries, and other resources, CoreIDRAW.com is a valuable information
resource for professional designers and occasional graphics users alike. Visit the
site today to discover the creations and inspirations of this growing community.

CorelIDRAW
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CorelDRAW Graphics Suite X4 provides advanced image-editing features that
help users get expected results the first time.

New! Corel PHOTO-PAINT® user interface: The Corel PHOTO-PAINT X4
user interface has been redesigned and modernized with new icons, menus, and
controls.
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The redesigned Corel PHOTO-PAINT user interface

New! Raw camera file support: CoreIDRAW Graphics Suite X4 now
supports raw camera file formats for more than 300 different types of cameras.
This lets users import raw camera files directly from their digital camera. With
interactive controls that provide real-time previews, users can view file
properties and camera settings, adjust image color and tone, and improve image
quality.

Camtes Raws Lot -1 of 1 images
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CorelDRAWV/ Graphics Suite X4 lets users work with raw camera files.

CorelIDRAW
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New! Straighten image: With CoreIDRAW Graphics Suite X4, users can
quickly and easily straighten images that were scanned or photographed at an
angle. The interactive controls, a grid with vertical and horizontal guidelines,
and an integrated histogram that provides results in real time, make it easier
than ever to straighten crooked images. In addition, users can choose to have
their images automatically cropped.

Users can quickly and easily straighten crooked images.

Straightening an image
1 In Corel PHOTO-PAINT X4, open an image that you want to straighten.

2 C(Click Adjust » Straighten Image.

3 In the Straighten Image dialog box, move the Rotate image slider, or
type a value between 15 and -15 in the Rotate image box.

4 To crop and straighten the image, enable the Crop image check box.

The image is cropped to preserve the aspect ratio of the original
image, which means that the final image is smaller than the original
image.

If you want to preserve the width and height of the original image,
enable the Crop and resample to original size check box. The final
image is resampled.

5 When you are satisfied with the result, click OK.

Enhanced! Adobe® Photoshop® CS3 support: Corel PHOTO-PAINT X4
provides support for Adobe Photoshop CS3 so that users can seamlessly
exchange files between the applications.

New! Histogram feedback: In CoreIDRAW Graphics Suite X4, more
features and effects now provide histogram feedback in real time. This lets users
edit images more efficiently by previewing changes and comparing results as
they adjust image tone, apply effects, or process raw camera files.
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Enhanced! Tone Curve adjustments: In Corel PHOTO-PAINT X4, the Tone
Curve dialog box has been enhanced to help users adjust their images with more
precision. With an integrated histogram, users now receive real-time feedback as
they make adjustments to their images. In addition, the new Eyedropper lets
users pinpoint specific color locations on the tone curve of their image. Users can
also select, add, or delete nodes along the tone curve.

Users now receive real-time feedback when adjusting the tone curve of an image.

Give it a try
Adjusting the tone curve of an image

1 In Corel PHOTO-PAINT X4, open an image that requires tone and color
adjustments.

Click Adjust » Tone Curve.

3 Inthe Tone Curve dialog box, use the tone curve on the graph to
adjust the balance between the shadows, midtones, and highlights of
the image.

The x-axis of the graph represents the tonal values of the original
image; the y-axis of the graph represents the adjusted tonal values.

4 To undo any unsatisfactory adjustments, click the Reset button.

When you are satisfied with the result, click OK.

CorelIDRAW
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The following is a list of the new and enhanced features offered by
CorelDRAW Graphics Suite X4.

¢ Enjoy the new, more intuitive user interface with redesigned and
modernized icons, menus, and controls.

¢ Use the new CoreIDRAW® ConceptShare™ to collaborate with colleagues
or clients in real time.

¢ Save time and enjoy more control over bitmap-to-vector conversion with the
enhanced Corel® PowerTRACE™ X4.

¢ Closely match colors between Corel and Microsoft applications with the new
Windows® Color System.

e Easily match colors between Corel and Adobe applications with the new
Adobe® Color Management Module.

¢ Easily combine a drawing with text from a data source by using the
enhanced Print Merge wizard.

¢ Let the customizable workspaces simplify the transition to
CorelDRAW Graphics Suite, or choose a preset workspace that resembles
Adobe® Photoshop®, Adobe® Illustrator®, or Microsoft® Office.

¢ Collaborate more easily with colleagues and clients by using the enhanced
support for PDF Comments.

e Automate workflow with enhanced support for Microsoft® Visual
Basic® for Applications 6.4.

e Gain more control over panning and zooming with enhanced
mouse-wheel scrolling.

e Get immediate access to the latest product updates, new content, and
special offers from within the application.
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¢ Take advantage of the enhanced Windows Vista® integration to easily
organize projects and search for files.

¢ Leverage an abundance of new, editable content which includes 10,000
clipart images and 1,000 high-quality photos.

e Ensure that output is optimized for its intended audience with a collection
of specialized fonts, including single-line engraving fonts and OpenType®
cross-platform fonts.

¢ Use the new, redesigned New From Template dialog box to find the
right template for any job.

e Access 80 professionally designed templates with notes about design
choices, output tips, and ways to maintain good design when customizing
templates.

¢ Experience enhanced compatibility with Adobe® products, including
Adobe® Photoshop® CS3, Adobe® lllustrator® CS3, PDF 1.7, PDF/A, and
Acrobat® 8.

¢ Enjoy seamless compatibility with commonly used file formats, including
new support for Microsoft® Publisher, as well as AutoCAD® DXF™,
AutoCAD® DWG™, and Corel® Painter™ X.

¢ Easily find Corel PHOTO-PAINT® files with new, high-quality thumbnail
previews.

¢ Use the new, interactive Table tool to provide structured layouts for text
and graphics.

e Experience greater layout freedom with new independent page layers.

e Enjoy the convenience of new, live text formatting to preview formatting
changes before they are applied.

e Save time by quickly identifying fonts with the new integration with
WhatTheFont™.

e Mirror paragraph text horizontally or vertically, or both.
e Customize quotation marks for specific languages.

e Save time with applications that use proper numeric formats by
recognizing the operating system’s regional settings.

e Quickly access recently used documents, templates, learning tools, and
inspiring designs from the new Welcome screen.

¢ View breathtaking projects and learn from seasoned design professionals
with the new CoreIDRAW® Handbook — Insights from the Experts.

¢ Delve into the 2 hours of new DVD training videos.

CorelIDRAW
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Access online, project-based instruction with new and updated tutorials
from CorelTUTOR™.

Visit CorelDRAW.com and share designs, ideas, and inspiration with this
growing online community.

Experience new support for raw camera files with interactive controls
that let users preview adjustments in real time.

Use new, interactive controls to quickly and easily straighten images.

Preview image-editing changes in real time by using histogram feedback,
available with more features than ever before.

Adjust images with more precision by using the enhanced Tone Curve
dialog box.

Get streamlined page sizes that better reflect the geographic location of
the user.
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As a trusted and versatile design tool, CoreDRAW Graphics Suite has been
embraced by graphic design professionals around the world, in areas as diverse
as airbrushing murals, vehicle illustration, magazine layout, and fashion design.
In the following pages, you'll find examples of the imagination and passion that
CorelDRAW Graphics Suite users bring to their projects.

CoreIDRAW
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Stefan Lindblad - Sweden Sergey Sezonov - Russia

Stefan Tetreault - Canada Rodolfo Biglié - Czech Republic
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Ariel Garaza Diaz - Spain Michaela Maginot - Germany

Rodolfo Biglié - Czech Republic Igor Tkac - United States of America
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Buffe Combe - United States of America Hugo Hansen - Denmark

Stefan Lindblad - Sweden Stanislav Pronin - Russia
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Stefan Tetreault - Canada Stefan Tetreault - Canada

Stefan Lindblad - Sweden Michaela Maginot - Germany

CoreIDRAW

GRAPHICS SUITE J(4 Reviewer’s Guide [ 27 ]



Corel is a leading developer of graphics, productivity, and digital media software, with more than 100
million users worldwide. The company’s product portfolio includes some of the world’s most popular and
widely recognized software brands, including Core DRAW® Graphics Suite, Corel® Paint Shop Pro®,
Corel® Painter™, Corel DESIGNER®, Corel® WordPerfect® Office, WinZip®, and iGrafx®. In 2006, Corel
acquired InterVideo, makers of WinDVD®, and Ulead, a leading developer of video, imaging, and DVD
authoring software. Designed to help people become more productive and express their creative
potential, Corel’s full-featured software products set a higher standard for value in being easier to learn
and use. The industry has responded with hundreds of awards recognizing Corel’s leadership in software
innovation, design, and value. Corel’s products are sold in more than 75 countries through a well-
established network of international resellers, retailers, original equipment manufacturers, online
providers, and Corel’s global Web sites. With its headquarters in Ottawa, Canada, the company has major
offices in the United States, the United Kingdom, Germany, China, and Japan. Corel’s stock is traded on
the NASDAQ under the symbol CREL and on the TSX under the symbol CRE.

Copyright © 2007 Corel Corporation. All rights reserved.
CoreIDRAW® Graphics Suite X4 Reviewer’s Guide

Protected by U.S. Patents 5652880; 5347620; 5767860; 6195100; 6385336; 6552725; 6657739; 6731309; 6825859; 6633305;
Patents Pending.

Product specifications, pricing, packaging, technical support and information (“specifications”) refer to the retail English
version only. The specifications for all other versions (including other language versions) may vary.

INFORMATION IS PROVIDED BY COREL ON AN “AS IS” BASIS, WITHOUT ANY OTHER WARRANTIES OR CONDITIONS,
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, WARRANTIES OF MERCHANTABLE QUALITY, SATISFACTORY
QUALITY, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, OR THOSE ARISING BY LAW, STATUTE, USAGE OF
TRADE, COURSE OF DEALING OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS OF THE INFORMATION PROVIDED OR
ITS USE IS ASSUMED BY YOU. COREL SHALL HAVE NO LIABILITY TO YOU OR ANY OTHER PERSON OR ENTITY FOR ANY
INDIRECT, INCIDENTAL, SPECIAL, OR CONSEQUENTIAL DAMAGES WHATSOEVER, INCLUDING, BUT NOT LIMITED TO, LOSS
OF REVENUE OR PROFIT, LOST OR DAMAGED DATA OR OTHER COMMERCIAL OR ECONOMIC LOSS, EVEN IF COREL HAS
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR THEY ARE FORESEEABLE. COREL IS ALSO NOT LIABLE FOR ANY
CLAIMS MADE BY ANY THIRD PARTY. COREL'S MAXIMUM AGGREGATE LIABILITY TO YOU SHALL NOT EXCEED THE COSTS
PAID BY YOU TO PURCHASE THE MATERIALS. SOME STATES/COUNTRIES DO NOT ALLOW EXCLUSIONS OR LIMITATIONS OF
LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, SO THE ABOVE LIMITATIONS MAY NOT APPLY TO YOU.

Corel, the Corel logo, CoreIDRAW, Corel DESIGNER, Corel PHOTO-PAINT, CorelTUTOR, iGrafx, Paint Shop Pro, Painter,
PowerTRACE, WinZip, WinDVD, and WordPerfect are trademarks or registered trademarks of Corel Corporation and/or its
subsidiaries in Canada, the U.S., and/or other countries.

Acrobat, Adobe, Illustrator, and Photoshop are either registered trademarks or trademarks of Adobe Systems Incorporated
in the United States and/or other countries. AutoCAD, DWG, and DXF are registered trademarks or trademarks of
Autodesk, Inc., in the USA and/or other countries. ConceptShare is a trademark of ConceptShare Inc. in Canada, the United
States and/or other countries. International Color Consortium is a registered trademark of the International Color
Consortium. Microsoft, OpenType, Visual Basic, Windows, and Windows Vista are either registered trademarks or
trademarks of Microsoft Corporation in the United States and/or other countries. MyFonts, MyFonts.com, and
WhatTheFont are registered trademarks or trademarks of MyFonts.com, Inc. Other product, font, and company names and
logos may be trademarks or registered trademarks of their respective companies.
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